IBM Cognos Business Viewpoint Client
Version 10.1.1

Installation and Configuration Guide

IBM
Product Information

This document applies to IBM Cognos Business Viewpoint Version 10.1.1 and may also apply to subsequent releases. To check for newer versions of this document, visit the IBM Cognos Information Centers [http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp].

Licensed Materials - Property of IBM

© Copyright IBM Corporation 2008, 2011.

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Introduction .................................. v

Chapter 1. Installation and testing checklist for IBM Cognos Business Viewpoint Client 1

Chapter 2. Setting up your IBM Cognos Business Viewpoint Client environment ..... 3
Reviewing software and hardware requirements for IBM Cognos Business Viewpoint Client ....... 3
Checklist for reviewing the environments of other products ........................................ 4
Interoperability of IBM Cognos Business Viewpoint with other products .................. 5

Chapter 3. Installing IBM Cognos Business Viewpoint Client ....................... 7
Set your JAVA_HOME variable ........................................ 7
Install IBM Cognos Business Viewpoint Client ........................................ 8
  Installing on Microsoft Windows ........................................ 8
  Installing on UNIX and Linux ....................................... 9
Install Cognos Planning Integration for Analyst and Contributor .......................... 10
  Uninstalling Cognos Planning Integration for Analyst and Contributor ................... 10
Configure IBM Cognos Business Viewpoint Client to connect to IBM Cognos Business Viewpoint Server ........................................ 11
Upgrade from an earlier version of Cognos Business Viewpoint Client .............. 11
Uninstalling Cognos Business Viewpoint Client ........................................ 12
  Uninstall Cognos Business Viewpoint Client on Windows operating systems .......... 12
  Uninstall Cognos Business Viewpoint Client on UNIX or Linux ..................... 13

Chapter 4. Configuring IBM Cognos Business Viewpoint Client adapters .......... 15
Configure the Analyst adapter ......................................... 15
  Update the system environment paths ................................ 15
  Configure the Analyst adapter ..................................... 15
Create a macro to start IBM Cognos Business Viewpoint Client from Analyst .......... 16
Configure the Contributor adapter for versions prior to 8.4 .............................. 19
Configure the Contributor adapter for version 8.4 and later .............................. 20
  Update the system environment path ................................ 20
  Configure the Contributor adapter ................................ 21
  Add a custom menu command to start IBM Cognos Business Viewpoint Client from Contributor .......... 21
Configure the Controller adapter ...................................... 23
Configure the CSV adapter ............................................ 24
Configure the IBM Cognos TM1 adapter ................................ 25
Configure the Transformer adapter .................................... 27
  Configure Transformer to launch IBM Cognos Business Viewpoint Client .......... 28
  Configuring IBM Cognos Business Viewpoint Client and Transformer for the UNIX operating system .......... 28
Configure the Relational adapter manually .................................. 29
Configure the IBM InfoSphere Master Data Management Server adapter ............. 30

Appendix A. Setting up an unattended installation and configuration ............... 33
Setting up an unattended installation .................................. 33
  Using a file generated by an installation on another computer ..................... 33
  Using the response.ats file ..................................... 34
Setting up an unattended configuration .................................. 35
Setting up an unattended uninstallation .................................. 36

Appendix B. Troubleshooting ........................................ 39
Log files ........................................ 39
Java out-of-memory exceptions ......................................... 41
Error verifying that security provider classes were loaded ............................ 42
Unable to read the contents of the keystore ..................................... 42
Library numbers already in use message starting Analyst .............................. 43
Introduction

With IBM® Cognos® Business Viewpoint Client, you can nominate dimensions from IBM Cognos Planning - Analyst, IBM Cognos Planning - Contributor Administration Console, IBM Cognos TM1®, IBM Cognos Controller, IBM Cognos Transformer, relational data sources, IBM InfoSphere™ Master Data Management Server, and CSV files into IBM Cognos Business Viewpoint Studio.

You can also update the dimensions that are in Business Viewpoint Studio with changes made in any of those components or data sources.

You can also subscribe to dimensions that are in Business Viewpoint Studio. For example, you nominate a Products dimension from one D-List of Analyst to Business Viewpoint Studio. You make changes to the Products dimension in Business Viewpoint Studio, and then subscribe to the Products dimension from a different Analyst D-List.

When you subscribe to a dimension from an IBM Cognos tool, like Analyst, a copy of the dimension from Business Viewpoint Studio is moved to Analyst. If the dimension is modified in either of these locations, the data will no longer be synchronized. To ensure that you have the same data in both places, you can run an update.

This document includes the information you need to install IBM Cognos Business Viewpoint Client.

Audience

This document is intended to help system administrators and information technology specialists install Business Viewpoint Client.

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access the IBM Cognos Business Viewpoint 10.1 information center at [http://publib.boulder.ibm.com/infocenter/cbv/v10r1m0/index.jsp](http://publib.boulder.ibm.com/infocenter/cbv/v10r1m0/index.jsp). Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. The installation wizard has accessibility features. For information on these features, see Appendix C, “Keyboard Shortcuts for the Installation Wizard,” on page 45.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.
Chapter 1. Installation and testing checklist for IBM Cognos Business Viewpoint Client

Review this checklist to ensure that you install and test the Cognos Business Viewpoint features that you want to deploy.

**Before you begin**

1. Install and configure Cognos Business Viewpoint Server.
   If you are upgrading from an earlier Business Viewpoint release and want to maintain existing Business Viewpoint Client subscriptions, record the name and ID for each adapter that you want to recreate before you upgrade Business Viewpoint Server and the Business Viewpoint clients.
   For more information, see “Upgrade from an earlier version of Cognos Business Viewpoint Client” on page 11.

2. Set up your environment. This task involves reviewing supported environments, verifying system requirements, and examining the environments of the IBM Cognos products that you want to work with Cognos Business Viewpoint.
   For more information, see Chapter 2, “Setting up your IBM Cognos Business Viewpoint Client environment,” on page 3.

**Procedure**

1. Install or upgrade Cognos Business Viewpoint Client.
   Install or upgrade Business Viewpoint Client to enable other IBM Cognos applications to interoperate with Business Viewpoint Studio. For more information, see Chapter 3, “Installing IBM Cognos Business Viewpoint Client,” on page 7.

2. Configure the connection to the Cognos Business Viewpoint Server.

3. Configure one or more adapters.
   For more information, see Chapter 4, “Configuring IBM Cognos Business Viewpoint Client adapters,” on page 15.
Chapter 2. Setting up your IBM Cognos Business Viewpoint Client environment

Before you install IBM Cognos Business Viewpoint Client, you must review requirements and set up resources in your environment so that the components can operate.

Procedure
1. Review the release notes for late-breaking issues, the list of environments that are supported by IBM Cognos products, as well as the minimum hardware and software requirements to install and run Business Viewpoint Client. For more information, see “Reviewing software and hardware requirements for IBM Cognos Business Viewpoint Client.”
2. Review the setup of the other products that you want to work with Business Viewpoint. For more information, see “Checklist for reviewing the environments of other products” on page 4.

What to do next
After you complete these tasks, you can install and configure Business Viewpoint Client. For more information, see Chapter 3, “Installing IBM Cognos Business Viewpoint Client,” on page 7.

Reviewing software and hardware requirements for IBM Cognos Business Viewpoint Client

To ensure your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for Cognos Business Viewpoint.

Before you begin

Review the latest list of environments supported by IBM Cognos products, including information on operating systems, patches, and browsers, by visiting the IBM Cognos Resource Center (http://www.ibm.com/software/data/cognos/customercenter/).


Procedure
1. Ensure that your system meets the minimum hardware requirements described in the following table to install and run Cognos Business Viewpoint Client.
Table 1. Minimum hardware requirements for Cognos Business Viewpoint Client

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>You must have one of the minimum supported version of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows</td>
</tr>
<tr>
<td></td>
<td>• The following UNIX operating systems:</td>
</tr>
<tr>
<td></td>
<td>– AIX</td>
</tr>
<tr>
<td></td>
<td>– HP-UX</td>
</tr>
<tr>
<td></td>
<td>– Oracle Solaris</td>
</tr>
<tr>
<td></td>
<td>• Linux</td>
</tr>
<tr>
<td></td>
<td>Note: There are many available versions of the Linux operating system that support many hardware platforms. Ensure that the IBM Cognos products support the operating system and hardware combination that you are using.</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components.</td>
</tr>
</tbody>
</table>

2. Ensure that your system meets the minimum software requirements described in the following table to install and run Cognos Business Viewpoint Client.

Table 2. Minimum software requirements for Cognos Business Viewpoint Client

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Runtime Environment (JRE)</td>
<td>An IBM JRE is installed automatically with Cognos Business Viewpoint Client on Windows operating systems.</td>
</tr>
<tr>
<td></td>
<td>Important: If you choose to use a different JRE, the version must be 1.5.0 or higher.</td>
</tr>
</tbody>
</table>

Checklist for reviewing the environments of other products

IBM Cognos Business Viewpoint Client enables other IBM Cognos products to integrate with Business Viewpoint Studio.

When you plan your installation of Business Viewpoint Client, you must first decide which IBM Cognos applications you require it to work with.

Important: You must install Business Viewpoint Client on the same computer as the IBM Cognos application that it will work with.
Use the following checklist to ensure that the environment where you want to install Business Viewpoint Client is suitable:

1. Ensure that a supported version of the other product is installed on the computer where you plan to install Business Viewpoint Client. For more information, see “Product versions supported by Cognos Business Viewpoint.”
2. Ensure that there are no firewall restrictions to prevent you from connecting to the computer where Business Viewpoint Server is installed.

Interoperability of IBM Cognos Business Viewpoint with other products

You can configure Cognos Business Viewpoint Client to operate with several other products. To help you decide which product adapters you need to configure, check the supported versions and the IBM Cognos features you can enable.

Product versions supported by Cognos Business Viewpoint

The following product versions are supported by Cognos Business Viewpoint:

- IBM Cognos Planning Analyst versions 8.1, 8.3, 8.4, and 10.1
- IBM Cognos Planning Contributor versions 7.3, 8.3, 8.4, and 10.1
- IBM Cognos Transformer version 8.4 and later
- IBM Cognos TM1 versions 9.4 and later
- IBM Cognos Controller version 8.3 and 10.1
- IBM InfoSphere Master Data Management Server

IBM Cognos product features that you can enable through Cognos Business Viewpoint Client

The following table describes how IBM Cognos product features are extended when their adaptors are configured in Cognos Business Viewpoint Client.

<table>
<thead>
<tr>
<th>IBM Cognos Product</th>
<th>Extended Features</th>
</tr>
</thead>
</table>
| IBM Cognos Planning Analyst | • The nomination of Analyst D-Lists can be updated in Cognos Business Viewpoint Studio.  
  • Subscribing to a Cognos Business Viewpoint hierarchy or dimension can allow multiple D-Lists to be centrally managed within Cognos Business Viewpoint.                                                                                                                |
| IBM Cognos Planning Contributor | • The nomination and management of Contributor E-Lists and rights lists can be updated in Cognos Business Viewpoint Studio. This allows for the central management of multiple E-Lists and rights lists using external security, as well as access tables.                                                                                   |
| IBM Cognos Transformer    | • Dimensions can be nominated and managed in Cognos Business Viewpoint.  
  • Multiple Transformer models can subscribe to a single dimension in Cognos Business Viewpoint and be centrally managed.                                                                                                                                                           |
Table 3. IBM Cognos product features enabled through Cognos Business Viewpoint Client (continued)

<table>
<thead>
<tr>
<th>IBM Cognos Product</th>
<th>Extended Features</th>
</tr>
</thead>
</table>
| IBM Cognos TM1              | • Bidirectional integration takes place between Cognos Business Viewpoint and IBM Cognos TM1 dimensions.  
                                | • Integration with the security model in IBM Cognos TM1 is also supported.          |
| IBM Cognos Controller       | • IBM Cognos Controller data can be added to an existing dimension in Cognos Business Viewpoint Studio. |
Chapter 3. Installing IBM Cognos Business Viewpoint Client

Install or upgrade IBM Cognos Business Viewpoint Client, then configure it to enable business users to nominate master dimensions into IBM Cognos Business Viewpoint Studio from the following components or data sources:

- IBM Cognos Planning Analyst
- IBM Cognos Planning Contributor Administration Console
- IBM Cognos TM1
- IBM Cognos Controller
- IBM Cognos Transformer
- Relational data sources
- IBM InfoSphere Master Data Management Server
- Comma-separated values (CSV) files

For information about the IBM Cognos products that you can integrate with IBM Cognos Business Viewpoint, see Chapter 4, “Configuring IBM Cognos Business Viewpoint Client adapters,” on page 15.

You can install the Business Viewpoint Client on UNIX or Linux operating systems. On Microsoft Windows, Business Viewpoint Client provides both a graphical interface and a command line interface. On UNIX and Linux operating systems, the client provides only a command line interface.

Set your JAVA_HOME variable

In some cases, you might need to set the JAVA_HOME variable.

For example:

- You want to use your own JRE and have a JAVA_HOME variable already set to that location on the Windows operating systems.
- You are installing on the UNIX or Linux operating system.

Ensure that the JAVA_HOME environment variable is set to the JRE location. For example, to set JAVA_HOME to a JRE that you are already using, the path is `Java_location/bin/jre/version`.

On Windows operating system, you can set JAVA_HOME as a system variable or a user variable. If you set it as a system variable, it might be necessary to restart your computer for the setting to take effect. If you set JAVA_HOME as a user variable, set it so that the environment in which Tomcat is running can access it.

If JAVA_HOME is set in the System Environment Variables and spaces are included, then the ViewpointClient command will not launch Business Viewpoint Client, and the ViewpointClientCLI command will not launch the Business Viewpoint Client Transformer adapter. To successfully set JAVA_HOME in those environments, you must use double quotation marks. For example, if you have `if '%JAVA_HOME%' == '' set JAVA_HOME=%JAVA_LOCAL%`, and if JAVA_HOME points to a directory with spaces (for example: `C:\Program Files\`), then the set command will fail with a syntax error. To correct this problem, replace the single quotation marks with double quotation marks as follows:
Install IBM Cognos Business Viewpoint Client

Install IBM Cognos Business Viewpoint Client to enable business users to nominate master dimensions from IBM Cognos Planning Analyst, IBM Cognos Planning Contributor Administration Console, IBM Cognos TM1, IBM Cognos Controller, IBM Cognos Transformer, relational data sources, IBM InfoSphere Master Data Management Server, and CSV files into IBM Cognos Business Viewpoint Studio.

Before you begin

Before you install IBM Cognos Business Viewpoint Client, you must complete the following tasks:
1. Install IBM Cognos Business Viewpoint Server.
   For more information, see the IBM Cognos Business Viewpoint Server Installation and Configuration Guide.
2. Set up your environment. This task involves reviewing supported environments, verifying system requirements, and examining the environments of the IBM Cognos products that you want to work with IBM Cognos Business Viewpoint.
   For more information, see Chapter 2, “Setting up your IBM Cognos Business Viewpoint Client environment,” on page 3.

Installing on Microsoft Windows

This topic describes how to install IBM Cognos Business Viewpoint Client on Microsoft Windows operating systems.

Procedure
1. Go to the computer that has an installed version of the IBM Cognos product that IBM Cognos Business Viewpoint Client will connect to.
   Important: If you install IBM Cognos Business Viewpoint Client on a different computer than the target application, IBM Cognos Business Viewpoint Client will not be able to connect to the application.
2. Insert the IBM Cognos Business Viewpoint Client disc or go to the location where the installation files were downloaded.
   The installation wizard starts automatically from the product disc.
3. On the Welcome page, click Next.
4. On the IBM License Agreement page, click I accept and then click Next.
5. On the Non IBM License Agreement page, click I accept and then click Next.
6. On the Installation Location page, accept or change the default location where IBM Cognos Business Viewpoint Client will be installed and click Next.
   Important:
   • If an IBM Cognos product was already installed in the default location, you must choose a different location.
   • You must install IBM Cognos Business Viewpoint Client on the same computer as the application.
7. On the Shortcut Folder page, accept or change the default folder where shortcuts to IBM Cognos Business Viewpoint Client will be installed and click Next.
8. On the **Summary** page, click **Next**.
9. On the **Finish** page, do one or more of the following tasks:
   - View the transfer log file.
   - View the summary error log file.
   - Choose to start IBM Cognos Configuration.
   - Click **Finish**.

**Installing on UNIX and Linux**

This topic describes how to install IBM Cognos Business Viewpoint Client on UNIX and Linux operating systems.

**Procedure**

1. On HP-UX, set the `M_ARENA_OPTS` environment variable as follows:

   ```
   _M_ARENA_OPTS 1:4
   ```

   This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.

2. If installing from a download, go to the location where the installation files were downloaded and extracted.

3. If installing from a disk, mount the disk using Rock Ridge file extensions.

   To mount the disk on HP-UX, do the following:
   - Add the `pfs_mount` directory in your path.
     - For example, type the following commands:
       ```
       PATH=/usr/sbin/:$PATH
       export PATH
       ```
   - To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`.
   - To mount the drive, type `pfs_mount -t rrip <device><mount_dir> -o xlat=unix`
     - For example, type the following command: `pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix`
     - You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
   - When the installation is complete, type `pfs_umount /cdrom` and kill the `pfsd` and `pfs_mountd` daemons to unmount the disk.

4. To start the installation wizard, go to the operating system directory and then type `. /issetup`.

5. Follow the directions in the installation wizard to copy the required files to your computer.

   Install the components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

6. On the **Finish** page, do one or more of the following before clicking **Finish**:
   - Note the location of the transfer log file.
   - Note the location of the summary error log file.
   - Choose to view the Release Notes.
   - Choose to start IBM Cognos Configuration.

7. Append the `install_location/bin` directory to the appropriate library path environment variable.
For Solaris and Linux, LD_LIBRARY_PATH
For AIX®, LIBPATH
For HP-UX, SHLIB_PATH

Install Cognos Planning Integration for Analyst and Contributor

If you are using IBM Cognos Business Viewpoint with IBM Cognos Planning - Analyst or IBM Cognos Planning - Contributor Administration Console, you must also install the Cognos Planning Integration component.

Before you begin

Before you begin, IBM Cognos Planning must be installed.

About this task

If you do not install Cognos Planning Integration in the same directory as Planning Analyst or Planning Contributor, you will not be able to launch Cognos Business Viewpoint Client from these features.

If you do not install Cognos Planning Integration, you must copy manually Cognos Business Viewpoint files in the Planning Analyst or Planning Contributor directories. You can optionally create a macro to launch Cognos Business Viewpoint from Analyst or Contributor even if the Cognos Planning Integration component is not installed. For more information, see “Create a macro to start IBM Cognos Business Viewpoint Client from Analyst” on page 16.

Procedure

1. Insert the IBM Cognos Business Viewpoint Client disc or go to the location where the installation files were downloaded.
2. Go to the Cognos Business Viewpoint Client installation folder, open the planningintegration\win32 folder, and double-click issetup.exe.
3. On the Welcome page, click Next.
4. On the IBM License Agreement page, click I accept and then click Next.
5. On the Installation Location page, accept or change the path to the location of the existing Analyst or Contributor installation and click Next.
6. On the Shortcut Folder page, accept or change the default folder where shortcuts to Cognos Business Viewpoint Client will be installed.
7. On the Summary page, click Next.

Uninstalling Cognos Planning Integration for Analyst and Contributor

In order for the Planning Server and the Cognos Business Viewpoint Client to exchange information, Cognos Business Viewpoint Client automatically installs files on the Planning Server. During the uninstallation process, Cognos Business Viewpoint Client is not authorized to remove these files and you must manually delete them.

Procedure

Follow the instructions in “Uninstalling IBM Cognos Planning Integration” (www.ibm.com/support/docview.wss?uid=swg21444946).
Configure IBM Cognos Business Viewpoint Client to connect to IBM Cognos Business Viewpoint Server

Configure IBM Cognos Business Viewpoint Client to an existing Cognos Business Viewpoint Server environment to enable other IBM Cognos products to operate with IBM Cognos Business Viewpoint Studio.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand **Environment** and click **Business Viewpoint Server**.
3. Enter the **Server host** and **Server port number** for the computer where IBM Cognos Business Viewpoint Server is installed.
4. Click **File > Save**.

   If you are prompted with a message stating that IBM Cognos Configuration cannot obtain a CA certificate from Content Manager, click **Yes** to allow you to proceed.

What to do next

Configure one or more adapters. For more information, see Chapter 4, “Configuring IBM Cognos Business Viewpoint Client adapters,” on page 15.

Upgrade from an earlier version of Cognos Business Viewpoint Client

When upgrading from one Cognos Business Viewpoint Server version to a newer version, administrators must also upgrade Cognos Business Viewpoint Client.

Before you begin

Cognos Business Viewpoint Client subscription information is stored in the Cognos Business Viewpoint repository. In order to maintain your existing Cognos Business Viewpoint Client subscriptions, you must keep track of the name and ID of each adapter that you want to recreate before you upgrade Cognos Business Viewpoint Server and Cognos Business Viewpoint Client.

To record your Cognos Business Viewpoint Client configuration:

1. Start IBM Cognos Configuration.
2. Use the following worksheet to record the required information of each adapter that you want to recreate:

   **Table 4. Sample Cognos Business Viewpoint Client configuration information**

<table>
<thead>
<tr>
<th>Adapter Information</th>
<th>Description</th>
<th>Sample Value</th>
<th>Your Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>A system-provided value.</td>
<td>TM1</td>
<td></td>
</tr>
<tr>
<td>Adapter Name</td>
<td>The name of the adapter.</td>
<td>TM1_GO</td>
<td></td>
</tr>
<tr>
<td>Adapter ID</td>
<td>The unique identification number of the adapter.</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>
To upgrade Cognos Business Viewpoint Client, perform these steps:

**Procedure**

1. Install the new version of Cognos Business Viewpoint Client. For more information, see Chapter 3, “Installing IBM Cognos Business Viewpoint Client,” on page 7.

2. Configure the connection to the Cognos Business Viewpoint Server. For more information, see “Configure IBM Cognos Business Viewpoint Client to connect to IBM Cognos Business Viewpoint Server” on page 11.

3. Configure one or more adapters to work with other IBM Cognos products, relational data sources, IBM InfoSphere Master Data Management Server, or comma-separated values (CSV) files. You can use the subscription information from the previous version or setup new resources.

**What to do next**

After you have completed the upgrade and tested the new version, you can uninstall the previous version.

**Uninstalling Cognos Business Viewpoint Client**

If you no longer require Cognos Business Viewpoint Client or have upgraded to a newer version, uninstall the version of Business Viewpoint Client that you do not need.

**Uninstall Cognos Business Viewpoint Client on Windows operating systems**

**Before you begin**

Log out and close Business Viewpoint Client before you uninstall it. Otherwise, some files might not be removed.

**Procedure**

1. From the Start menu, find the program representing the Business Viewpoint Client version that you want to remove. For example, click All Programs, IBM Cognos Business Viewpoint Client 8.4.1, Uninstall IBM Cognos Business Viewpoint Client, Uninstall IBM Cognos Business Viewpoint Client.

   The Uninstall wizard appears.

   **Tip:** IBM Cognos Business Viewpoint Client is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the components. The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.
Tip: To find the log file, look in the Temp directory.

3. Delete all temporary Internet files from the web browser computers. For more information, see your web browser documentation.

**Uninstall Cognos Business Viewpoint Client on UNIX or Linux**

**Before you begin**

Log out and close Business Viewpoint Client before you uninstall Business Viewpoint Client and the Business Viewpoint service. Otherwise, some files might not be removed.

**Procedure**

1. To uninstall Cognos Business Viewpoint Client, go to the `install_location/uninstall` directory and type the appropriate command:
   
   - If you use XWindows, type `./uninst -u v`.
   - If you do not use XWindows, do an unattended uninstallation. For more information, see “Setting up an unattended uninstallation” on page 36.

2. Follow the instructions to uninstall the components.

3. Delete all temporary Internet files from the web browser computers. For more information, see your web browser documentation.
Chapter 4. Configuring IBM Cognos Business Viewpoint
Client adapters

You must configure IBM Cognos Business Viewpoint Client adapters to work with other IBM Cognos products, relational data sources, IBM InfoSphere Master Data Management Server, or comma-separated values (CSV) files.

After you configure one or more adapters, you can transfer data between IBM Cognos Business Viewpoint Studio and the other applications.

Configure the Analyst adapter

You can perform configuration that allows IBM Cognos Planning Analyst users to work with IBM Cognos Business Viewpoint.

To configure the Analyst adapter:
1. Update two system environment paths to point to the appropriate bin directory.
2. Configure the Analyst adapter to enable communication between the Analyst environment and the IBM Cognos Business Viewpoint environment.
3. Install Planning Integration for Analyst or copy manually Business Viewpoint files in the Planning Analyst or Planning Contributor directories.
4. Optionally, create a macro that starts IBM Cognos Business Viewpoint Client from Planning Analyst.

Update the system environment paths

The system environment paths must point to the appropriate Business Viewpoint Client directory.

Procedure
1. Add an environment variable named BVC_HOME.
2. Set the value of BVC_HOME to the BusinessViewpointClient\bin directory.
   For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin.
3. Add an environment variable named BVC_ANALYST_HOME.
4. Set the value of BVC_ANALYST_HOME to the IBM Cognos Planning Analyst\bin directory.
   For example, C:\Program Files\IBM\Cognos\planning\bin.

Results

You might need to log off and log on again before the environment variables take effect.

Configure the Analyst adapter

The Analyst adapter must be configured to enable communication between the Analyst environment and the IBM Cognos Business Viewpoint environment.

Procedure
1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.

3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.

4. Enter Analyst for the name of the adapter. This will match the name referenced in the macro that is installed as part of the Planning Integration installation.

   **Important:** The name of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click Analyst and click OK.

6. To activate the adapter's configuration, set Enabled to True.

7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.

8. Click the version of Analyst that you are using.

9. Enter a user name and password. If you leave the user credentials information blank, the adapter will prompt for them when the adapter is launched. If you specify them, all users with access to this computer will share the same credential information when they use this adapter.

10. Enter a namespace. This step is optional depending on the Analyst version that you are using.

11. Save and close IBM Cognos Configuration.

**What to do next**

If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.

You can optionally create a macro to start IBM Cognos Business Viewpoint Client when you click a custom toolbar button in Analyst. For more information, see “Create a macro to start IBM Cognos Business Viewpoint Client from Analyst.”

**Create a macro to start IBM Cognos Business Viewpoint Client from Analyst**

You can create a macro that will start IBM Cognos Business Viewpoint Client when you click a custom toolbar button in Analyst.

You can use one of the following methods:

- Use Planning Integration to create a macro named LaunchBVC and a new library named BusinessViewpointClient.

  You must install Planning Integration before you can create the macro. To install Planning Integration, see “Install Cognos Planning Integration for Analyst and Contributor” on page 10.

- Create the macro manually if you want to select an existing library or if you have already customized the Analyst toolbar with other custom macros.

  **Notes:**
If you are also configuring the Contributor adapter, you must use the same process as you use for the Analyst adapter. For example, if you manually create the macro for Analyst, you must also manually create the menu command for Contributor.

If you install Planning Integration to create the Analyst adapter, you do not have to install Planning Integration again to use with Contributor.

Use Planning Integration to create the macro
This topic describes how to use Planning Integration to create a macro that you can use to launch Business Viewpoint Client.

Before you begin
Before you begin, ensure that you have installed Planning Integration. For more information, see "Install Cognos Planning Integration for Analyst and Contributor" on page 10.

Procedure
1. If this is the first time that you have installed IBM Cognos Business Viewpoint Client, go to the Analyst_location\bin folder and double-click the LibrarySetupAnalystXX.bat file where XX is the version of Analyst that you have.
   For example, if you are using Analyst version 8.4, double-click the LibrarySetupAnalyst84.bat file.
   
   Note: If you are using Analyst version 8.1, you must use the LibrarySetupAnalyst73.bat file.
   The .bat file adds a registry entry that results in a library with ID 70040001 being created the next time you start Analyst.
2. Start Analyst.
3. Click Tools > Macros > Open Macro.
4. Double-click the LaunchBVC macro and do the following:
   a. In the Pathname box, add the full path to the LaunchViewpointClient.bat file that is in the Analyst\bin directory.
      For example, C:\Program Files\IBM\Cognos\c10\bin\LaunchViewpointClient.bat
   b. If you did not use the name Analyst for the adapter in IBM Cognos Configuration, change the name of the adapter to match the one that you used.
   c. Save and close the macro.

What to do next
1. Restart Analyst and click the custom toolbar button called Start Business Viewpoint Client.
2. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.
   For example, if you named the adapter "Analyst" in IBM Cognos Configuration, double-click the file named ViewpointClient_Analyst.cmd.
Create the macro manually

You can manually create a macro to start Cognos Business Viewpoint Client from Analyst if you want to select an existing library or if you have already customized the Analyst toolbar with other custom macros.

Before you begin

1. Determine the library ID number that you will be using in Planning - Analyst:
   a. Start Analyst
   b. Click File > Administration.
   c. Click the Maintain Libraries and Users tab.
   d. In the Libraries tab, note the number for the library you are using.
   e. Click Close.
2. Copy the following files to the Analyst_location folder:
   a. Go to the BusinessViewpointClient_location\IntegrationComponents\Analyst directory.
   b. Open the folder for the version of Analyst that you are using, such as Analyst 84.
   c. Copy the .dll file and the .msg files to the Analyst_location\bin directory.
   d. If you are using Analyst version 8.1, copy the files named XPJMDM02.UP1 and XPJMDM03.UP1 to the Analyst_location\bin\system directory. The files are located in the BusinessViewpointClient_location\IntegrationComponents\Analyst\misc directory.

Procedure

1. To create a macro that runs a file:
   a. From Analyst, click Tools > Macros > New Macro.
   b. Click Insert.
   c. From the Group list on the left, select Control.
   d. From the Function list on the right, select Run.
   e. Click Next.
   f. In the Pathname box, add the full path to the ViewpointClient_<adaptername>.cmd file that is in the BusinessViewpointClient_location\bin\launchers directory. Note that <adaptername> is the name of the Analyst adapter configured in IBM Cognos Configuration. For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\ViewpointClient_Analyst.cmd
   g. From the Options box, select Exit to specify what the macro will do after running the .cmd file.
   h. Click Finish.
   i. Save the macro and name it LaunchBVC.
2. Update the customtoolbar.txt file:
   a. Go to BusinessViewpointClient_location\IntegrationComponents\Analyst\misc directory and open the file named customtoolbar.txt.
   b. Ensure that the location of the icon_consumerservice_16.bmp file is in the same location as the customtoolbar.txt file and that the path is correct. For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\IntegrationComponents\Analyst\misc\icon_consumerservice_16.bmp.
   c. Change the library ID to match the one you noted in Analyst. By default, the library ID in this file is 70040001.
d. Save and close the file.

For more information about custom toolbar text files, see the IBM Cognos Planning - Analyst User Guide.

3. Specify the location of the custom toolbar.txt file:
   a. From Analyst, click Tools > Options.
   b. Click the Custom tab.
   c. Click Browse beside the Custom Toolbar File box, and navigate to the location of the customtoolbar.txt file.
      The customtoolbar.txt file is located in the BusinessViewpointClient_location\IntegrationComponents\Analyst\misc directory. For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\IntegrationComponents\Analyst\misc\customtoolbar.txt.
   d. Click OK.

What to do next
1. Restart Analyst and click the custom toolbar button to start IBM Cognos Business Viewpoint Client.
   If IBM Cognos Business Viewpoint Client does not start, you might need to log off and then log on again. Or you might need to review the path in the macro you created to ensure that it is correct.
2. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.
   For example, if you named the adapter "Analyst" in IBM Cognos Configuration, double-click the file named ViewpointClient_Analyst.cmd.

Configure the Contributor adapter for versions prior to 8.4

You can perform configuration that allows users of Contributor versions prior to 8.4 to run IBM Cognos Business Viewpoint from the Contributor Administration Console (CAC).

Procedure
1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Contributor prior to version 8.4 and click OK.
6. To activate the adapter’s configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   Important: The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. In the User Import Location box, enter the location from which E.Lists, AccessTables, and CAC rights can be imported. For example, type 
D:/temp/userImportExportLocation/

9. In the User Export Location box, enter the location to which E.Lists, AccessTables, and CAC rights can be exported. For example, type 
D:/temp/userImportExportLocation/

10. Save and close IBM Cognos Configuration.

What to do next
1. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.

2. Test the configuration by double-clicking the file named 
ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.

For example, if you named the adapter “ContributorAdapter” in IBM Cognos Configuration, double-click the file named 
ViewpointClient_ContributorAdapter.cmd.

Configure the Contributor adapter for version 8.4 and later

You can perform configuration that allows users of Contributor version 8.4 and later versions to run IBM Cognos Business Viewpoint Client from the Contributor Administration Console (CAC).

To configure the Contributor adapter:
• Update the system environment path.

Tip: If you have already updated the system path for Analyst, you do not need to perform this task.

• Configure the Contributor adapter.

• Optionally, create a macro that starts Cognos Business Viewpoint from Planning Contributor.

Update the system environment path

The system environment path must point to the appropriate Business Viewpoint Client directory.

Procedure
1. Add an environment variable named BVC_HOME
2. Set the value of BVC_HOME to the BusinessViewpointClient\bin directory.
   For example, C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin.

Results

You might need to log off and log back on before the environment variables take effect.
Configure the Contributor adapter

The Contributor adapter must be configured to enable communication between the Contributor environment and the IBM Cognos Business Viewpoint environment.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource Adapter.
4. Enter a name for the adapter. Use ContributorAdapter to match the name referenced in the macro that is installed as part of the Planning Integration installation.

   **Important:** The names of each adapter must be unique to the computer on which Cognos Business Viewpoint Client is installed.

5. In the Type box, click Contributor version 8.4 or later and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.

8. In the IBM Cognos dispatcher URI box, type http://servername:9300/p2pd/servlet/dispatch, where servername is the name of the IBM Cognos dispatcher computer.
9. Enter the IBM Cognos namespace ID and the IBM Cognos user name and password. If you leave the user credentials information blank, the adapter will prompt for them when the adapter is launched. If you specify them, all users with access to this computer will share the same credential information when they use this adapter.
10. Save and close IBM Cognos Configuration.

What to do next

- If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.
- You can optionally create a macro to start Cognos Business Viewpoint Client from the Tools menu in the Contributor Administration Console.

Add a custom menu command to start IBM Cognos Business Viewpoint Client from Contributor

You can create a menu command that will start IBM Cognos Business Viewpoint Client when you click a menu button in Contributor.

Notes:

- If you installed Planning Integration to create the Analyst adapter, you do not have to install Planning Integration again to use with Contributor.
If you are also configuring the Analyst adapter, you must use the same process for creating the macro as you use for the Contributor adapter. For example, if you manually create the menu command for Contributor, you must also manually create the macro for Analyst.

Use Planning Integration to create the macro
This topic describes how to use Planning Integration to create the macro.

Before you begin
Ensure you have installed Planning Integration. For more information, see "Install Cognos Planning Integration for Analyst and Contributor" on page 10.

Procedure
Edit the file that is installed as follows:

- Open the file ViewpointClientConfig.xml from the Contributor_location\bin folder.
  
  Tip: This file adds a command to the Tools menu in the Contributor Administrator Console that starts IBM Cognos Business Viewpoint Client.
- If you want to use a different caption, replace the string "Business Viewpoint Client" with a new caption.
- If you did not use the name ContributorAdapter in IBM Cognos Configuration, replace [AdapterName] with the name you used for the adapter.

What to do next
1. Start Contributor.
2. Click Tools > Business Viewpoint Client.
3. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.
   
   For example, if you named the adapter "ContributorAdapter" in IBM Cognos Configuration, double-click the file named ViewpointClient_ContributorAdapter.cmd.

Create the macro manually
This topic describes how to create the macro manually.

Procedure
1. Go to BusinessViewpointClient_location\IntegrationComponents\Contributor directory and open the file named ViewpointClientConfig.xml.
2. Find the following line:
   
   `<Resource ID="Command Line">cmd /c "[BV Client Install Location]\bin\launchers\viewpointclient.cmd" [AdapterName]"</Resource>
   
3. Change the following values:
   
   a. Change [BV Client Install Location] to the actual path of your install location. For example, change "[BV Client Install Location]\bin\launchers\viewpointclient.cmd" to something like: "C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\viewpointclient.cmd"
   
   b. Change [AdapterName] to Contributor.
For example, when you are finished the line should look something like

```bash
<Resource ID="Command Line">cmd /c
"C:\Program Files\IBM\Cognos\BusinessViewpointClient\bin\launchers\viewpointclient.cmd"
Contributor</Resource>
```

4. Save and close the file.
5. Copy ViewpointClientConfig.xml to the Contributor_location\bin folder.

**What to do next**

Restart Contributor to access the macro.

---

**Configure the Controller adapter**

You can perform configuration that allows Controller users to run IBM Cognos Business Viewpoint.

**Procedure**

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.

   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Controller and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. Enter the Controller user name.
9. In the Explorer window, right-click the adapter you just added, and then click New resource > Database.

   **Tip:** This is the database used by Controller.
10. Enter a name describing the Controller database, select the database type, and then click OK.
11. In the Resource Properties window, do the following:
   - Enter the computer name and port number of the database server.
   - Enter a user ID and password that has unrestricted access to the database server.
   - If you are connecting to a Microsoft SQL Server database, enter the name it was given when it was created in Microsoft SQL Server.
   - If you are connecting to an Oracle database, enter the service name of the database instance.
12. Save and close IBM Cognos Configuration.
What to do next

1. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.

2. Start IBM Cognos Controller.


4. Define the structure using the following steps:
   a. Define Account Structure and default specification as #ST_ACCSTRUC
   b. Click Save As and save this structure with the name BV_ACCSTRUC.
   c. Repeat the steps above for Company Structure, Extended Dimensions 1-4, and Currency Conversion Rates saving the default specifications #ST_xxxxx using the following names:
      • For COMPANY_STRUCTUR, use BV_COMPSTRUC
      • For EXT_DIM1_STRUCTUR, use BV_EXTDIM1
      • For EXT_DIM2_STRUCTUR, use BV_EXTDIM2
      • For EXT_DIM3_STRUCTUR, use BV_EXTDIM3
      • For EXT_DIM4_STRUCTUR, use BV_EXTDIM4
      • For CURRENCY_CONV_RATES, use BV_CURRRATES

5. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.
   For example, if you named the adapter "Controller" in IBM Cognos Configuration, double-click the file named ViewpointClient_Controller.cmd.

Configure the CSV adapter

You configure the CSV adapter so that IBM Cognos Business Viewpoint Client users can work with CSV files.

To configure the CSV adapter, you must specify where the CSV files are read from and written to.

Before you begin

The directory for the CSV files must already exist on your system. IBM Cognos Business Viewpoint Client will not create it.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.

2. Expand Environment and click Business Viewpoint Client Adapters.

3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.

4. Enter a name for the adapter.

   Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.

5. In the Type box, click CSV files and click OK.
6. To activate the adapter’s configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.

    Important: The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. In the CSV file location box, enter the directory where you want to store temporary CSV files. For example, type C:/temp/csvAdapterStore/
9. Save and close IBM Cognos Configuration.

**What to do next**

1. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.
2. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd, where adapter_name is the name you gave the adapter. The file is located in the BusinessViewpointClient\bin\launchers folder.
   For example, if you named the adapter "CSV" in IBM Cognos Configuration, double-click the file named ViewpointClient_CSV.cmd.

---

**Configure the IBM Cognos TM1 adapter**

You configure the IBM Cognos TM1 adapter so that IBM Cognos TM1 users can work with IBM Cognos Business Viewpoint Client.

**Procedure**

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   
   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click TM1 and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.

   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. From the TM1 Version box, select the version you are accessing.
9. Enter the name of the IBM Cognos TM1 server that was defined in IBM Cognos TM1 Architect.
   
   **Important:** This value is case sensitive.
10. Enter the computer name of the IBM Cognos TM1 Admin host.
11. In the **TM1 shared network path** box, enter the location of a shared network directory to which both the IBM Cognos TM1 server and the IBM Cognos Business Viewpoint client have read and write access.

12. Set security for IBM Cognos TM1:
   - To use native security in IBM Cognos TM1, enter the user name and password in the **TM1 user name and password** box.
   - To use IBM Cognos security in IBM Cognos TM1:
     - To setup this adapter to prompt for user credentials, leave the following boxes blank:
       - IBM Cognos gateway URI
       - IBM Cognos namespace ID
       - IBM Cognos username and password
     - To setup this adapter to not prompt for user credentials:
       a. Enter the gateway information in the **IBM Cognos gateway URI** box, such as `http://localhost:80/cognos8/cgi-bin/cognos.cgi` or `http://server_name:9300/p2pd/servlet/dispatch/ext`.

       **Important**: IBM Cognos TM1 and IBM Cognos Business Viewpoint must use the same IBM Cognos instance for security.

       b. Enter the name of the namespace in the **IBM Cognos namespace ID** box.

       c. Enter the user name and password in the **IBM Cognos username and password** box.

       **Important**: If you provide user credentials and namespace information, all users with access to this computer will be sharing the same credentials and namespace when they use this adapter.

13. Save and close IBM Cognos Configuration.

**What to do next**

1. If you are finished configuring adapters, go to the `BusinessViewpointClient_location\bin\launchers` location and double-click the file named `generateFiles.cmd`. The utility will set up all the adapters that you configured by connecting to the IBM Cognos TM1 server for each IBM Cognos TM1 adapter, copying scripts to the IBM Cognos TM1 server data directory, and creating the link in IBM Cognos Business Viewpoint Client to the adapter.

2. In the folder `BusinessViewpointClient\bin\launchers`, double-click the file named `setupTM1Adapters.cmd`. IBM Cognos TM1 files and scripts are copied to the required directories.

3. Restart the IBM Cognos TM1 Server service.

4. Test the configuration by double-clicking the file named `ViewpointClient_adapter_name.cmd`, where `adapter_name` is the name you gave the adapter. The file is located in the `BusinessViewpointClient\bin\launchers` folder.

   For example, if you named the adapter "TM1" in IBM Cognos Configuration, double-click the file named `ViewpointClient_TM1.cmd`. 

---

Configure the Transformer adapter

You can perform configuration that allows IBM Cognos Business Intelligence Transformer users to work with IBM Cognos Business Viewpoint.

About this task

If you use IBM Cognos 8 Transformer 8.4, install the IBM Cognos 8 v4 Business Intelligence Server Component Fix Pack. Before you install the IBM Cognos 8 v4 BI Server Component Fix Pack, back up any customized files from the current installation. To check your version, open the file named cmplst.txt, and check the line that starts with COGTR_version=. The file is located in the install_location\cognos\c8 directory.

Important: The IBM Cognos 8 v4 Business Intelligence Server Component Fix Pack is not a standalone installation. It must be installed on computers that have IBM Cognos 8 Transformer 8.4 installed.

If you have IBM Cognos 8 Transformer 8.4.1 or later installed, you do not have to install the Fix Pack.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Transformer and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   Important: The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. Save and close IBM Cognos Configuration.

What to do next

1. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.
2. Test the configuration by double-clicking the file named ViewpointClient_adapter_name.cmd in the BusinessViewpointClient\bin\launchers folder where adapter_name is the name you gave the adapter.
   For example, if you named the adapter "Transformer" in IBM Cognos Configuration, double-click the file named ViewpointClient_Transformer.cmd.
Configure Transformer to launch IBM Cognos Business Viewpoint Client

You must configure IBM Cognos Transformer to enable integration with IBM Cognos Business Viewpoint Client.

Before you begin

Ensure that you have configured the IBM Cognos Business Viewpoint Transformer adapter before you configure Transformer to launch IBM Cognos Business Viewpoint Client. For more information, see "Configure Transformer to launch IBM Cognos Business Viewpoint Client."

Procedure

1. Start Transformer.
2. Click File > Preferences and locate the Business Viewpoint tab.
   
   Note: If you do not see the Business Viewpoint tab, ensure that you have the correct version of Transformer installed.
3. Click Enable Business Viewpoint Integration.
4. Click Browse and locate the ViewpointClientCLI.cmd file found in the IBM Cognos Business Viewpoint Client <install_location>\bin\launchers directory.
5. Type the Transformer adapter name. This is the Transformer adapter name that was added in the IBM Cognos Configuration for IBM Cognos Business Viewpoint Client. If the Transformer adapter was not added, you should do so now. For more information, see the IBM Cognos Business Viewpoint Client Installation And Configuration Guide.
6. Click the General tab and ensure that the Save Object Unique Identifier values in MDL check box is selected.
7. Click OK to save your changes.

Configuring IBM Cognos Business Viewpoint Client and Transformer for the UNIX operating system

You can use IBM Cognos Business Viewpoint Client and IBM Cognos Transformer in the UNIX operating system.

After you install IBM Cognos Business Viewpoint Client and Transformer in the UNIX operating system, you need to perform additional steps to enable the integration.

When configuring IBM Cognos Business Viewpoint Client using IBM Cognos Configuration, ensure that the adapter ID is the same as the one used for Windows to define subscriptions for the model. A subscription includes the path to the Transformer model file. Store the model under the Models directory as defined in the Transformer preferences so the subscription contains a path relative to the Models directory that is valid on both the Microsoft Windows operating system and the UNIX operating system.

Defining preferences

Define the following preferences related to IBM Cognos Business Viewpoint Client integration in the Transformer preferences section located in the configuration cogtr.xml file.

- `<Preference Name="VSAdapter" Value="adapter-name" />`
<Preference Name="VSEnable" Value="1" />
<Preference Name="VSPath" Value="install-path/bin/launcher/
ViewpointClientCLI.sh" />
<Preference Name="ModelSaveDirectory" Value="model-save-path" />

The Transformer adapter in IBM Cognos Business Viewpoint Client also needs the
ModelSaveDirectory defined in the configuration file named cogtr.xml.
Alternatively, you can create a symbolic link to the Transformer cogtr.xml file.

---

Configure the Relational adapter manually

By default, the Relational adapter is configured during installation. You can manually configure IBM Cognos Business Viewpoint Client to work with relational data sources directly.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   
   **Important:** The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click Relational Database and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   
   **Important:** The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. Save and close IBM Cognos Configuration.

Results

The adapter is created in BusinessViewpointClient\bin\launchers folder.

What to do next

To test the configuration:

1. Click Start > Program Files > Business Viewpoint Client > Business Viewpoint Client Relational Adapter
2. Double-click the file named ViewpointClient_adapter_name.cmd, where
   adapter_name is the name you gave the adapter. The file is located in the
   BusinessViewpointClient\bin\launchers folder.
   
   For example, if you named the adapter “RelationalAdapter” in IBM Cognos Configuration, double-click the file named
   ViewpointClient_RelationalAdapter.cmd.
Configure the IBM InfoSphere Master Data Management Server adapter

You can configure IBM Cognos Business Viewpoint Client to work with IBM InfoSphere Master Data Management Server.

Before you begin

Before you begin, create or confirm the location of the database and staging database used in IBM InfoSphere Master Data Management Server.

Procedure

1. Start IBM Cognos Configuration, if you did not start it from the installation wizard.
2. Expand Environment and click Business Viewpoint Client Adapters.
3. Right-click Business Viewpoint Client Adapters, and then click New resource > Adapter.
4. Enter a name for the adapter.
   Important: The names of each adapter must be unique to the computer on which IBM Cognos Business Viewpoint Client is installed.
5. In the Type box, click IBM InfoSphere Master Data Management Server and click OK.
6. To activate the adapter's configuration, set Enabled to True.
7. In the Adapter ID box, enter a unique numeric value.
   Important: The IDs of all adapter configuration instances on the same IBM Cognos Business Viewpoint server must be unique. This includes adapter instances on other computers that are connected to the same server.
8. In the IBM InfoSphere Master Data Management Server Database connection string box, enter the location where the data is read from when it is loaded into IBM Cognos Business Viewpoint Studio.
   The string must be in the following format:
   USERID=<userid>,PASSWORD=<password>,SCHEMA=<schema>,
   CONNECTION_STRING=jdbc:db2j:net://<server>:<port>/<dbname>,
   DRIVER=com.ibm.db2.jcc.DB2Driver
   For example,
   USERID=mdmuser, PASSWORD=user4mdm, SCHEMA=MDM_BVC_VIEWS,
   CONNECTION_STRING=jdbc:db2j:net://10.10.10.10:50000/mdm,
   DRIVER=com.ibm.db2.jcc.DB2Driver
9. In the IBM InfoSphere Master Data Management Server Staging Database connection string box, enter the location where data is written when updating data from IBM Cognos Business Viewpoint Studio to IBM InfoSphere Master Data Management Server.
   This connection string information uses the same syntax as above.
10. Save and close IBM Cognos Configuration.

What to do next

1. If you are finished configuring adapters, go to the BusinessViewpointClient\bin\launchers folder and double-click the file named generateFiles.cmd. This utility creates startup scripts for launching all the adapters that you configured. You can configure many different adapters and generate all the startup scripts at the same time.
2. Test the configuration by double-clicking the file named
ViewpointClient\adapter_name.cmd, where \adapter_name\ is the name you gave
the adapter. The file is located in the BusinessViewpointClient\bin\launchers
folder.

For example, if you named the adapter "MDMServerAdapter" in IBM Cognos
Configuration, double-click the file named
ViewpointClient_MDMServerAdapter.cmd.
Appendix A. Setting up an unattended installation and configuration

Set up an unattended installation and configuration to perform the following tasks:
- Install an identical configuration across several computers on your network.
- Automate the installation and configuration process by specifying options and settings for users.
- Install and configure components in a UNIX or Linux operating system that does not have XWindows.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all other software that you need is installed and configured.

To set up an unattended installation and configuration, perform the following tasks:
1. Configure a transfer specification file (.ats) to specify installation options.
2. Run the installation tool in silent mode.
3. Use a configuration file from another computer.
4. Run the configuration tool in silent mode.

After you complete these tasks, ensure that the IBM Cognos Business Viewpoint installation directory on all computers is protected from unauthorized or inappropriate access. Then you will be ready to use Business Viewpoint.

Setting up an unattended installation

Use a transfer specification file (.ats) to copy IBM Cognos Business Viewpoint components to your computer without being prompted for information.

By default, each time you install Business Viewpoint using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed Business Viewpoint on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the CD. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Using a file generated by an installation on another computer

This topic describes how to set up an unattended installation using a file generated by another computer.
**Procedure**

1. Use the installation wizard to install Business Viewpoint on one computer.
2. Go to `Business_Viewpoint_installation_location/instlog`.
3. Locate the transfer specification file (.ats) that was generated.
   The filename format is ts-BV-version-yyyymmdd_hhmm.ats
4. Copy the transfer specification file to the computer where you plan to install Business Viewpoint.
5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.
6. In a text editor, open the transfer specification file that you copied.
7. In the section named License Agreement, change the ACCEPTED= property to y.
8. Save the transfer specification file in the directory where you copied the contents of the installation CD.
9. Install Business Viewpoint:
   - On a Microsoft Windows operating system, open a **Command Prompt** window, and change to the win32 directory where you copied the contents of the CD, and then type the following command, where `location` is the directory where you copied `filename`, the transfer specification file:
     ```bash
     issetup -s location/filename.ats
     ```
   - On a UNIX or Linux operating system, change to the directory where you copied the contents of the CD, and in the directory for your operating system, type the following command, where `location` is where you copied `filename`, the transfer specification file:
     ```bash
     ./issetup -s location/filename.ats
     ```

**Results**

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the `Business_Viewpoint_installation_location\instlog` directory in a summary error log file. The filename format is tl-BV-version-yyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

**Using the response.ats file**

This topic describes how to set up an unattended installation using the response.ats file.

**Procedure**

1. On the target computer, insert the CD and copy the contents to your computer.
2. Go to the operating system directory and open the response.ats file in a text editor.
Each section in the response.ats file corresponds to a dialog box in the installation wizard.

3. In the section named License Agreement, change the ACCEPTED= property to y.

4. Type the installation location of the program files for IBM Cognos Business Viewpoint Client in APPDIR=location.

   Tip: There should be no space on either side of the equal sign (=).

5. For IBM Cognos Business Viewpoint Client, in the section named [Component List], next to each component:
   • To install the component, type 1
   • To not install the component, type 0

   Note: All required files are installed.

6. For a Windows installation, for the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.

   Tip: To ensure that the shortcut folder is visible to all users, type 1 for the ALLUSERS_FLAG= property.

7. For the install information in the [Install Conditions] section:
   • To specify the condition is true, type 1
   • To specify the condition is false, type 0

8. Save the response.ats file to a local directory after you make the necessary changes.

9. Go to the operating system directory.

10. At the command prompt type the following command, where location is the directory where you copied response.ats:
    • On the Windows operating system, type
      `issetup -s location/response.ats`
    • On the UNIX or Linux operating system, type
      `. /issetup -s location/response.ats`

Results

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the c10_location\instlog directory in a summary error log file. The filename format is tl-BV-version-yyyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

Setting up an unattended configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has IBM Cognos Business Viewpoint installed. You can then run IBM Cognos Configuration in silent mode.
The exported configuration contains the properties of IBM Cognos Business Viewpoint that you installed on the source computer.

**Before you begin**

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos Business Viewpoint computer with the same installed components.

**Procedure**

1. In IBM Cognos Configuration, click **File > Export as**.
2. To export the current configuration to a different folder, in the **Look in** box, locate and open the folder.
   
   Ensure that the folder is protected from unauthorized or inappropriate access.
3. In the **File name** box, type a name for the configuration file.
4. Click **Save**.
5. Copy the exported configuration file from the source computer or network location to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.
6. Rename the file to `cogstartup.xml`.
7. If you changed the global configuration on the source computer, copy the `coglocale.xml` file from the source computer to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.
8. Go to `Business_Viewpoint_installation_location/bin`.
9. Type the configuration command:
   
   - On the Windows operating systems, type `cogconfig.bat -s`
   - On the UNIX or Linux operating system, type `./cogconfig.sh -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the `cogconfig_response.csv` file in the `Business_Viewpoint_installation_location/logs` directory.
   
   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success, and all other values indicate an error.

**Results**

IBM Cognos Configuration applies the configuration settings that are specified in the local copy of `cogstartup.xml`, encrypts credentials, generates digital certificates, and starts the Tomcat server.

**Setting up an unattended uninstallation**

Use this method to automate the removal of components on several computers that have the same components or to remove components in a UNIX or Linux operating system that does not have XWindows.
**Procedure**

1. Go to `Business_Viewpoint_installation_location/instlog`.

2. In a text editor, open the transfer specification .ats file for the product.
   - The filename format of the transfer specification .ats file is `ts-BV-version-yyyyMMdd_hhmm.ats`
   - If you have more than one .ats file, you only need to edit one of the .ats files.

3. In the section named [Component List], specify the components to remove by doing one of the following:
   - To remove the component, type 1
   - To leave the component installed, type 0

4. Save and close the file.

5. Go to the operating system directory.

6. At the command prompt, type the following command, where `filename` is the name of the transfer specification .ats file that you edited:
   - On the Windows operating systems,
     
     `uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats`
   - On the UNIX or Linux operating system,
     
     `./uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats`
Appendix B. Troubleshooting

Use this troubleshooting information as a resource to help you solve specific problems you may encounter during or after the installation of IBM Cognos Business Viewpoint Client.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you. Another valuable troubleshooting tool is the Knowledge Base, which is available on the IBM Cognos Resource Center [http://www.ibm.com/software/data/support/cognos_crc.html]. The Knowledge Base is a database of problems and solutions for all IBM Cognos products.

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Log files

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product.

Operations performed in IBM Cognos Business Viewpoint Client are recorded in various log files for tracking purposes. For example, if you experienced problems installing Cognos Business Viewpoint Client, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

When troubleshooting, the following files can assist you.

Transfer log file

This file records the activities that the installation wizard performed while transferring files. The transfer log file is located in the Business_Viewpoint_Server_installation_location\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

tl-MDMCS-8.1-0.0-20080901_1122.txt

Transfer summary-error log file

This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components. The transfer summary-error log file is located in the Business_Viewpoint_Server_installation_location\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:
Startup configuration file

This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml. If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file. The backup configuration files are located in the Business_Viewpoint_Server_installation_location/configuration directory. The following is an example of the file name format for backup configuration files:

cogstartup_200811231540.xml

Startup configuration lock file

This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window. If you experience problems opening IBM Cognos Configuration, you can check the Business_Viewpoint_Server_installation_location/configuration directory for the cogstartup.lock file. If the file exists and IBM Cognos Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. You can delete the lock file and then open IBM Cognos Configuration.

Locale configuration file

This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support. If you experience problems with language support in the user interface or in reports, use these files to track your changes. The backup configuration files are located in the Business_Viewpoint_Server_installation_location/configuration directory. The following is an example of the file name format:

coglocale_200811231540.xml

Uninstallation log file

This file records the activities that the Uninstall wizard performed while uninstalling files. The log file is named cognos_uninst_log.htm and is located in the Temp directory. You can use the log file to troubleshoot problems related to uninstalling Cognos Business Viewpoint Client.

Silent mode log file

This file records the activities that IBM Cognos Configuration performed while running in silent mode. This log file is named cogconfig_response.csv and is located in the Business_Viewpoint_Client_installation_location/logs directory.

Business Viewpoint Client runtime log file

This file records any errors that IBM Cognos Business Viewpoint Client encounters while running. This log file is named cs_logs.log and is located in the Business_Viewpoint_Client_installation_location/logs directory. You can record additional errors and events in this file by performing the following steps:

1. Go to the Business_Viewpoint_Client_installation_location/bin directory.
2. Edit the log4j.properties file. Follow the instructions in the file to determine which lines you should be commenting or uncommenting out.
3. Save the file and relaunch Cognos Business Viewpoint Client.

**Business Viewpoint relational adapter runtime log file**

This file records any errors generated when running the Cognos Business Viewpoint relational adapter as well as the number of rows updated and any SQL errors encountered. This log file is named cs_logs_ra.log and is located in the Business_Viewpoint_Client_installation_location/logs directory. You can record additional errors and events in this file by performing the following steps:

1. Go to the Business_Viewpoint_Client_installation_location/bin directory.
2. Edit the log4j.properties file. Follow the instructions in the file to determine which lines you should be commenting or uncommenting out.
3. Save the file and relaunch Cognos Business Viewpoint Client.

*Note:* You can change the amount of logging in this file starting in Cognos Business Viewpoint version 10.1.1 and later.

---

**Java out-of-memory exceptions**

When using IBM Cognos Business Viewpoint Client, errors might be generated when not enough memory is allocated for Java processes.

**About this task**

You might encounter the following errors:

- Java script errors, returning text similar to *Could not load 'consumer.Application'; last tried '/bv/consumer/Application.js'.*
- A blank Business Viewpoint Client window.
- Java out-of-memory exceptions.

To solve these errors, you can refresh your browser window. If these errors occur frequently, you can increase the amount of memory allocated for Java processes to either 2 GB or 3 GB.

**Procedure**

- To increase the amount of memory for the adapters that are already defined:
  1. Go to the BusinessViewpointClient\bin\launchers directory.
     The .cmd files contain the information for the adapters that are currently configured.
  2. Edit the .cmd files for each adapter:
     a. Find the following line:
        ```
        for machines with 1 GB RAM
        ```
     b. Go to the next line (that contains the characters VM_OPTS), and comment out the line.
     c. Uncomment either the VM_OPTS line that applies to 2 GB or the VM_OPTS line that applies to 3 GB.
     d. Save the file.
Important: These changes will be overwritten the next time generateFiles.cmd is run unless you update the adapter configuration templates.

- To update the adapter configuration templates to increase the amount of memory in future adapter configurations:
  1. Go to the BusinessViewpointClient\bin directory.
     The following .template files are used to generate the startup scripts for the following adapters:
     Analyst adapter  
     ViewpointClient-analyst.template  
     TM1 adapter  
     ViewpointClient-TM1Adapter.template  
     All other adapters  
     ViewpointClient-common.template  
  2. Edit the .template files for the adapters that you use:
     a. Find the following line:
        for machines with 1 GB RAM  
     b. Go to the next line that contains the characters VM_OPTS, and comment it out.
     c. Uncomment either the VM_OPTS line that applies to 2 GB or the VM_OPTS line that applies to 3 GB.
     d. Save the file.

Error verifying that security provider classes were loaded

When you start IBM Cognos Business Viewpoint Client, an error might be generated while loading security provider classes.

The following message is displayed:
com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1085  
An error occurred while verifying that the security provider classes were loaded.  

This message displays because the JAVA_HOME environment variable is pointing to your copy of Java Runtime Environment (JRE) or JDK. However, the .jar (Java Archive) file, named bcprov-jdknn-nnn.jar, was not copied to your JRE.

To fix the problem, copy the bcprov-jdknn-nnn.jar file from the Business Viewpoint_installation_location/bin/jre/version/lib/ext directory to the Java_location/jre/lib/ext directory.

Unable to read the contents of the keystore

When you start IBM Cognos Business Viewpoint Client, an error message might be generated to indicate that Cognos Business Viewpoint Client is unable to read the contents of the keystore.

The following message might be displayed:
com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1064
Unable to process the PKCS #7 data because of an internal error. Unable
to read the contents of the keystore
'C:/Program Files/IBM Cognos/BusinessViewpoint/configuration/csk\jCSKKeystore'.
Reason: java.io.IOException: com.sun.crypto.provider.SealedObjectForKeyProtector

These error messages display because the following events took place:
• Cognos Business Viewpoint Client was configured while the JAVA_HOME
  environment variable was pointing to the Sun version of Java Runtime
  Environment (JRE) or JDK. As a result, the product configuration was encrypted
  by the Sun JRE.
• JAVA_HOME was removed from your environment.
• Because JAVA_HOME was no longer set, Cognos Business Viewpoint Client
  used the IBM version of JRE that was bundled with Cognos Business Viewpoint
  Client.
• The IBM JRE could not decrypt the product configuration that was originally
  encrypted by the Sun JRE.

To fix the problem, choose one of the following options:
• Restore JAVA_HOME back to its original value, pointing to the Sun version of
  JRE or JDK.
• Verify that JAVA_HOME is not set. Then, reinstall Cognos Business Viewpoint
  Client and use the IBM JRE.

Library numbers already in use message starting Analyst

When you start Analyst, an error message might be generated to indicate that
library numbers are already in use.

The following message might be shown:
Installation of the following directories failed during startup,
because some of the library numbers are already in use: 70040001

This can occur if you have installed a previous version of the Planning Integration
Kit or you have run AnalystRegistryUtility.exe. Both the Planning Integration Kit
and the AnalystRegistryUtility.exe create a registry key. If this registry key is
present, Analyst will show an error when you start it.

To resolve this problem, you must delete the registry key:
1. Open the Microsoft Windows Registry Editor,
2. Locate the registry key named DEFLIB 70040001. The key is located under
   HKEY_CURRENT_USER\SOFTWARE\Cognos\Planning##\Analyst\Startup
3. Delete DEFLIB 70040001.
4. Follow the steps to use Planning Integration again.
Appendix C. Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

Table 5. List of keyboard shortcuts on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

Table 6. List of keyboard shortcuts on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

Table 7. List of keyboard shortcuts on the License Agreement page

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo, ibm.com, TM1, and Cognos are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "[Copyright and trademark information]" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
# Index

**A**  
Analyst adapters  
  configuring 15  
  audience of document 5  

**B**  
Business Viewpoint Client 12  

**C**  
cogstartup.lock file 40  
configuration  
  lock file 40  
  unable to open IBM Cognos Configuration 40  
  unattended 36  
  workflows 1  
configuration files  
  exporting 36  
configuring  
  Analyst adapters 15  
  Business Viewpoint Client 11  
  Business Viewpoint Client adapters 15  
  Contributor adapters 19, 20  
  Controller adapters 23  
  CSV adapters 24  
  InfoSphere Master Data Management Server adapters 30  
  relational adapters 29  
  TM1 adapters 25  
  Transformer adapters 27  
  unattended 36  
configuring Transformer for Business Viewpoint Client 28  
Contributor adapters  
  configuring 19, 20  
Controller adapters  
  configuring 23  
CSV adapters  
  configuring 24  

**D**  
description of product 5  

**E**  
environment  
  setting up 3  
environments  
  supported 3  
exporting  
  configuration files 36  

**I**  
IBM Cognos Configuration  
  problems opening 40  
  unattended mode 36  
InfoSphere Master Data Management Server adapters  
  configuring 30  
installation  
  workflows 1  
installing  
  Business Viewpoint Client 8  
IBM Cognos 8 33  
Planning Integration 10  
unattended install 33, 34  
using transfer specification file (.ats) 33  
using transfer specification files (.ats) 34  

**J**  
java out-of-memory errors 41  

**K**  
keyboard shortcuts 45  
keystore error message 42  

**L**  
log files 39  
locale configuration 40  
relational adapter 41  
runtime client 40  
silent mode 40  
startup configuration 40  
transfer 39  
transfer summary 39  
uninstallation 40  

**M**  
macro  
  creating 17, 22  
migrating to different environment 11  

**O**  
out-of-memory exception 41  

**P**  
Planning Integration 17, 20, 22  
  installing 10  
preparing to install 3  
problems opening IBM Cognos Configuration 40  
purpose of document 5  

**R**  
relational adapters  
  configuring 29  
response.ats file 33  

© Copyright IBM Corp. 2008, 2011